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The objective of project 4480 was to build an environmental
management system by using a visual or map based approach to
develop new ways to manage environmental data on a large farm or an
estate of several farms.  Geographic information system (GIS)
techniques are extremely powerful, but they tend to be complex, and
often require a high degree of skill and training in order to use them.
Using systems analysis, the fundamental environmental management
data were identified and a simplified spatial approach was developed to
manage these environmental data.

Johnstown Castle Research Centre consists of three farms,
ornamental grounds, forests, lakes and streams.  A set of database
tables was generated to hold farm environmental data on these farms.
These included: 

annual management summary data giving the average number of
different types of animals, the amount of organic manure and N,
P and K nutrients produced by them, fertiliser purchases, organic
and chemical nutrient usage on the farm, achievement of nutrient
management planning targets, etc.
monthly livestock information recording the numbers of livestock
of different types for the three farms, together with management
comments on the changes and transfer that take place over the
month,
detailed land use and nutrient use information for each field or
plot on the estate,
recent soil analyses information for the experimental plots,
analysis results of recent water samples which are taken regularly
at sampling points throughout the estate.

The topographical, soil and site features were digitised, in order to
collect information on the overall and individual farm boundaries.  This
included roads, hedges and ditches, streams, rivers and lakes, the
buildings and most particularly, the boundaries of all field and
experimental plots.  When the digitisation was complete, a set of
bespoke programs was built, using the GIS system, ArcView.  To make
the system "user friendly", the menu system was customised by
removing complex features; retaining only those buttons and menu
options that served a purpose useful to the application.  The programs
were unified into a PC system called Johnstown Castle Environmental
Monitoring System or JCEMS. 
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For the future, it is envisaged that the maps and spatial techniques
will be embodied into an Access database system and developed for use
by other research stations and farms. 

An environmental management system (EMS) for a large farm or
Research Centre must be capable of managing and monitoring the
chemical and organic nutrients applied to land, the status of soils and
their sensitivity to runoff and the possibility of ground water
contamination.  It should consider and record the usage of each plot of
land, the cropping, whether the land is used for grazing or silage, the
soil tests, chemical and organic fertilisers recommended and the
amounts actually used.  Recording all of these features effectively
requires a spatial database system for data recording and management
in order that the nutrients supplied to crops and animals may be
minimised, and optimum use made of nutrients available as animal
manures. 

Carton (1998) developed a nutrient management planning system
for Johnstown Castle.  This was a traditional information system,
which used Excel spreadsheet tables to record, store and calculate
nutrient requirements, purchases and usage for the farms.  This
tabular based system can handle summarised soil, crop and
environmental information, but management of detailed nutrient data
at field scale requires that the relationship between nutrient use and
efficiency be related to soil, water and topographical variables and this
too requires the use of a GIS approach.  

The requirement to create a spatial EMS for a large farm was
fulfilled by developing a system to cater for the Research Centre of
three farms, lakes, rivers and ornamental grounds at Johnstown
Castle.  It builds on the techniques found useful in Coulter et al, (1998)
"Enhancing and visualising data on soils, land use and the
environment" and Coulter  et al, (1998) "Visual Environmental Data on
Soils and Landuse".  It also builds on the techniques of nutrient
management planning as implemented as Teagasc policy for all of its
farms.  The Code of Good Agricultural Practice (1996) defines the aim
of nutrient management -- to prevent water pollution by achieving the
correct balance between crop requirements and nutrient application
rates from organic and chemical fertilisers, taking account of nutrients
available in the soil.

2
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The system is designed to be used for farm management and does
not require users to have GIS skills to use it effectively.  However, in its
present form, it requires the presence of expensive GIS software, and
its overall supervision will require annual maintenance of the
databases and spatial sources.  It is envisaged that the maps and
spatial techniques will be translated to a license free visual system and
embodied into an Access or some other readily available database
system.  The aim would be to allow JCEMS to manage the
environmental data from other research stations and farm estates that
had a similar high level of management information recording.  It could
also be extended to include visual displays of information for other
experimental point, line or polygon data on the estate in question.  It
would be particularly appropriate for monitoring of point data on river
catchments and the system could be extended to interactive internet
display of live environmental data.

Johnstown Castle Research Centre provides national research
information on soils and the environment. In addition it is the home of
the Teagasc Analytical Services Laboratory for soil, herbage, water and
general agricultural materials.  The Castle and Estate lies 7 km south
west of Wexford at Murntown and is located at national grid reference
T 020170.

The grounds of Johnstown Castle consist of an Estate of 450
hectares, and include Johnstown Castle Research Centre, and Teagasc
analytical laboratories, the headquarters of the Environmental
Protection Agency, a number of sections of the Department of
Agriculture and Rural Development and of the Department of Forestry
and the Wexford Organisation for Rural Development.  In all, there are
over 550 personnel working on the Estate in these various
organisations.

There are three Teagasc experimental farms in the Estate, 10 ha of
lakes and streams, 40 ha of ornamental lawns and woodland and 2.3
ha of formal gardens.  In addition, there are 74 ha of woodland, some
of it riparian and some commercial conifer forest, an experimental ash
plantation and a new, 60 ha plantation of oak and beech species.

3

THE JOHNSTOWN CASTLE ESTATE
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Summary Data on the Experimental Farms

Of the 214 ha of farmed area, more than 97% is grassland; the small
amount of tillage was planted as part of the organic farming system.  In
the year 2000, there were 123 ha of grazing land and 84.5 ha of silage.

The three research farms on the estate were designated on the basis
of the experimental programme: there is a Dairy Farm of 75 ha, an
Organic Dairy Farm of 55 ha and a Beef Farm of 83 ha.  These are
shown in Fig 1.  The two dairy herds are completely experimental while
the beef farm is mainly experimental with some fields containing
commercial animals.

A summary of the land usage on the three farms is given in table 1
and the livestock numbers of the farms on January 1, 2000 is given in
table 2.

4

Table 1:  Land use on the Johnstown Castle Research Centre

Dairy Organic Dairy Beef Total

Grazing 46.9 19.1 56.9 122.9

Silage 28.4 29.6 26.5 84.5

Tillage - 6.7 - 6.7

Total 75.3 55.4 83.4 214.1

Table 2:  Livestock numbers on 1-1-2000

Dairy Organic Dairy Beef Total

Cows 98 22 4 124

Heifers in Calf 25 22 - 47

Cattle 0 - 1 10 8 42 60

Cattle 1 - 2 14 3 157 174

Heavy Cattle/Bulls 2 1 45 48

Total 75.3 55.4 83.4 453
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The mean stocking rate for the grassland area was 2.5 LU/ha in
2000.  The average milk yield for the year 2000 season was 4,500 l/cow
in the organic farm and 5,400 l/cow in the dairy.

Soil Fertility: There are 182 experimental plots and fields among the
three farms and these are sampled regularly for lime requirement (LR),
phosphorus (P), potassium (K) and magnesium (Mg).  In the sampling
season September 1999 to April 2000, the mean lime requirement and
nutrient levels for the farmed area were LR 4.4 t/ha, P 4.5 mg/l, K 122
and Mg 295.  

The average P level of 4.5 mg/l broke down into P index categories
of 45% at index 1, 30% at index 2, 19% at index 3 and 7 % at index 4.
These low values reflect that samples were largely from P-trial
experimental plots rather than land farmed commercially.  The
corresponding breakdown of K soil test values was 14% at index 1, 29%
at index 2, 31% at index 3 and 26% at index 4.

The soil fertility summary of the levels for the three farms in the
1999-2000 season is given in table 3.

5

Table 3:  Soil fertility summary for the Johnstown Castle farms

Farm LimeRequirement P K Mg

tonnes/ha mg/l

Beef 4.1 7.1 125 356

Dairy 6.1 5.5 134 288

Organic 3.2 2.8 110 276

Overall 4.4 4.5 122 295
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The distribution of P and K indices for the three farms are given in
tables 4 and 5.

These data show that the beef and dairy systems are much more fertile
than the organic farming system.

The summary data presented for the three farms represent valuable
management data and can be used to monitor herd performance,
achievement of yield targets, nutrient management planning and so on.
However, nutrient management and monitoring on a large farm, and
particularly on an experimental farm, requires tools to aid examination
of soil fertility measurements and organic and chemical nutrient
application data on a field-by-field basis.

The purpose of this project was the development of a management
system to facilitate the collection, management, analysis and modelling

6

Table 5:  Distribution of K levels

Potassium Index 1 Index 2 Index 3 Index 4
0 - 50 mg/l 51 - 100 mg/l 101 - 150 mg/l > 150 mg/l

Beef 4 21 47 28

Dairy 1 39 30 30

Organic 27 25 25 23

Overall 14 29 31 26

SPATIAL TECHNIQUES FOR MANAGING FARM DATA

Table 4:  Distribution of P levels

Phosphorus Index 1 Index 2 Index 3 Index 4
0 - 3 mg/l 3.1 - 6 mg/l 6.1 - 10 mg/l > 10 mg/l

Beef 31 15 32 22

Dairy 22 42 30 7

Organic 68 26 5 1

Overall 45 30 19 7
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of detailed fertility and nutrient application data.  A spatial database
arrangement was deemed to be essential to ensure that the relationships
between use of nutrients and fertility of the land could be examined in
detail.  This should consist of a combination of GIS tools for visualisation
and display, with relational database modules to manage, validate,
transform and update the farm information in a manner easily accessible
to the user.  It was essential that the system is designed to be clear and
easily operated, so that the user may have access to vital environmental
information about the farming system.

The GIS System
The project began by the digitising all topographical features, soil

survey maps and site maps for the Research Centre using PC ArcInfo1.
This spatial data capture process included individual farm boundaries,
field and experimental boundaries, roads, rivers, lakes, hedgerows and
buildings.  The measurable characteristics or attributes of those
features relevant to environmental and fertility management were
examined and databases were constructed using a simple data
structure whenever possible.  This was followed by the collection of
data on the operation of the Johnstown Castle farming systems, to
determine which observable data were relevant to a detailed farm
management and monitoring system.  When the digitisation was
complete, a GIS "project" was built using ArcView2.   ArcView is a more
'user-friendly' program than the more powerful ArcInfo system. It has
the great advantage that, following the minimum of training, staff with
little or no experience of GIS systems can use it.  To further facilitate
this, the menu system can be simplified by removing unnecessary or
complex features, retaining only useful buttons and menu options.

The layout of the Research Centre is illustrated in Figure 1, which
shows the division into three farms, and the location of the buildings,
ornamental grounds, lakes and woodland.  

The Structure of Electronic Maps and Spatial Data 
Johnstown Castle Environmental Monitoring System (JCEMS) is a

desktop PC geographic information system (GIS).  The system was built
using ArcView.  

The information scheme consists of five electronic maps known by
the GIS system as "shapefiles" or more simply as e-maps.  Each e-map
is linked to a spatial database table by the GIS system.  Each table
forms part of an associated e-map; thus, the spatial database table
contains information about the enclosed areas or polygons.  Usually
however, only unchanging information is kept in the spatial database
and user data are kept in linked or related databases.  Only these are

7
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user-modifiable.  This protection is useful because it would be unwise
to allow users to edit a spatial database for fear of damage to the
integrity of its spatial characteristics.  

Three of the e-maps are of central importance to the project.  (1)
Outline consists of the boundary lines of the Research Centre and the
three farms within it; (2) Plots, contains the boundary of each field and
bounded area, i.e. the experimental plots, lakes, buildings, major
roadways and car parks, the ornamental grounds, gardens and woods
and (3) Soil Survey contains both the boundaries of the plots and the
boundaries of the soil mapping units on the estate.

1,2  ArcInfo and ArcView are GIS software packages by ESRI. Redlands, CA, USA

8

Figure 1.  Layout of the Johnstown Castle Research Centre
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These are polygon e-maps because each area within the electronic
map has a closed boundary (i.e. a polygon) and is labelled with an
identity tag, which is a number that links the polygon to a record in its
spatial database table.

There are two line e-maps, Roads for roads and pathways and
Rivers for rivers and streams, which originate or pass through the
Research Centre. Currently these line features are not internally
labelled, though it is planned to extend the line coverages to include
infrastructure features such as sewage, electricity, telephone and data
pathways and so on.

Finally, there is one point e-map, Waters, which contains the
location of sampling points for water quality in the streams and lakes.
As with polygon e-maps, these points are labelled internally so that
current information on water quality may be displayed or graphed.

The Database Structure
The main information database tables are the Farm Summary table,

which is linked to the Outline e-map; and the Nutrients and the Soil
Analysis tables, which are linked the Plot e-map.  There is also a water
sample results table linked to the points in the Waters e-map and a Soil
Survey information table linked to the Soil Survey e-map.

The Farm Summary Table 
The Farm Summary table contains information or details about the

farms and major land divisions within the Research Centre.  In this
scheme, the land-use classifications within the research centre include
beef, dairy and organic farm, ornamental and forestry land, built area,
lakes etc.  Contained in the details are the overall farmed area, animal,
the mean number of livestock of different kinds, the mean dates of
animal turnout and housing on each farm, the annual manure
production, slurry tank capacity, fertiliser nutrients purchased etc.
The database variable names and their meanings are given in table 6.

The Nutrients Table
The nutrients table contains nutrient and other data about each

plot, field and bounded area in the Research Centre.  For non-
farmland, these include lakes, roadways, the buildings, car parks, and
site boundaries belonging to Teagasc, EPA and the Department of
Agriculture and Rural Development; for these areas,  the information
is absent or mainly descriptive.  

9
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The Animal Table

For experimental plots and fields on farmland, the nutrient table
contains details of its present landuse (e.g. organic farm, forestry); crop
(e.g. grazing, silage, feeding barley), nutrient status and so on.  A full
list of variables is given in table 7.

The animal table consists of the monthly stock count for the
different animal types.  Table 8 shows the list of database variables.

The Soil Analysis Table
The soil analysis table consists of the most recent soil analytical

results for the fields and experimental plots on the farms.  Table 9
shows the list of database variables for soil analysis information.
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Table 6:  Recorded variables in farm summary table

Item Name Description

LAND_USER Used to hold the farm name

DATE_IN Mean date animals were housed

DATE_OUT Date turned out

SUM_AREA Area of farm

SEASON Farming season

COWS Number of dairy cows

COWS_CULL Number of cows culled

COWS_OTHER Other cows

H_IN_CALF Heifers in calf

BREED_12 Females for breeding one to two years

BREED_01 Females for breeding less than one year

OTHER_01 Number of other cattle less than 1 year

BULLS Number of bulls

N_AN Nitrogen produced by animals

P_AN Phosphorus produced by animals

K_AN Potassium produced by animals

N_FERT Nitrogen fertiliser inorganic

P_FERT Phosphorus fertiliser inorganic

K_FERT Potassium fertiliser inorganic

SLURY_TANK Slurry capacity

SLURY_USED Slurry spread on land

SLURY_PROD Slurry produced
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Table 7:  Recorded variables in nutrients table

Item Name Description

PLOT_CODE Field Identification code
LANDUSE Farm enterprise
NXCROP Next crop
PCROP Previous crop
AN_N_NUT_S Animal N
AN_P_NUT_S Animal P
AN_K_NUT_S Animal K
CHEM_N_NUT Inorganic N
CHEM_P_NUT Inorganic P
CHEM_K_NUT Inorganic K
N_R Nitrogen required
P_R Phosphorus required
K_R Potassium required
DATEREC Sample date

Table 8:  Recorded variables in animals table

Item Name Description

LANDUSE Farm enterprise
DATE_STOCK Stock taking date
COWS Number of dairy cows
COWS_CULL Number of cows culled
COWS_OTHER Number of other cows
H_IN_CALF Number of heifers in calf
BREED_12 Females for breeding one to two years
BREED_01 Females for breeding less than one year
OTHER_01 Number of other cattle less than 1 year
BULLS Number of bulls
LU_PRESENT Present livestock units
N_AN Nitrogen produced by animals
P_AN Phosphorus produced by animals
K_AN Potassium produced by animals
N_FERT Nitrogen fertiliser inorganic
P_FERT Phosphorus fertiliser inorganic
K_FERT Potassium fertiliser inorganic
SLURY_PROD Slurry produced
SLURY_USED Slurry spread on land
COMMENT Farm managers comments re: animal transfers
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The Water Table
The water table consists of point data that is the results of analysis

of water samples at the water sampling points within the estate.  The
table is used for display and presentation of water purity status and
also contains the eight most recent analyses; this is the maximum
number of points that can be clearly visualised on graphs at any one
time.  Table 10 shows the variables recorded in the database.

The Soil Survey Table
The Soil Survey table (Table 11) consists of descriptive data that

arising from a detailed soil survey within the estate.  The e-map was
obtained by digitisation of the soil map of Johnstown Castle (Diamond,
1983) and merging this e-map with the Plots e-map in order that both
sets of polygon features would be available for query.

12

Table 9:  Recorded variables in soil analysis table

Item Name Description

FIELDNAME Advisory field identifier
DATE Sample date
LIME Lime requirement
P Phosphorus
K Potassium
SETCODE Laboratory identification code
SAML Advisor Identification Code
SAMN Advisor sample code

Table 10:  Recorded variables in water information table

Item Name Description

OIDENT Sample point identification number
SOURCE Sample source (Lake/River)
DATE Sample date
pH pH levels
P Phosphorus
TON Total oxidisable nitrogen
NH4N Ammonium N
SC Salt levels
SETCODE Laboratory identification code
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In order to make JCEMS intuitive and easy to use, all of its main
functions are separated into separate programs, and each one is
started by double clicking the appropriate icon on the desktop
(computer screen).  There are icons to run the spatial systems to
manage the Farm Summary, Nutrients, Soil Fertility and Soil Survey
databases.  When the user is finished with the program and closes it,
changes they have made to the layout, for example by zooming into
maps, querying graphs etc., are not saved, so the program always
restarts with the optimised arrangement of maps, tables, graphs etc.
However, the user is entitled to update or change the numeric
databases concerning the above systems and these changes are stored.

Changes to the numeric data may be made by editing the data bases
directly or by running a program incorporated for the purpose as a
button in the spatial system.  For example, the Farm Summary
database contains annual average number of animals of different
types.  These data can be entered by the user but for convenience,
there is a pushbutton in Nutrients program which when pressed,
requests the starting and finishing date, and will calculate and insert
the means directly.  These data are used by the program to calculate
the annual quantity of animal manure produced on each farm and the
quantity of N, P and K contained in it.   On the other hand, the annual
quantities of chemical nutrients used on each farm must be entered
directly by the user.

The Map Controls
There is a map view element with each display produced and when

the map element is selected, a number of tool buttons or controls
appears above it.  The buttons are illustrated in Figure 2.  The active
button stays depressed until  another button is depressed.  The
Identify button      is shown depressed in the figure.

13

USING THE SPATIAL SYSTEM

Table 11:  Recorded variables in soil survey table

Item Name Description

NEW_CODE Farm plot identification code
TEXTURE Soil texture description
DRAINAGE Drainage class
SOILGROUP Soil group category
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On the top or menu line, only File is active, the remainder are
simply headings to describe the functions of the buttons below them.
The File menu choices are self-explanatory i.e. Close, Print, Print
Setup, Export and Exit.  Operation of the Query button is complex and
is described in Appendix 1.  The Unselect button leaves all elements
unselected.  

When a tool button is clicked, the cursor changes, to show which
one is being used.  The Identify button displays a table of information
about any element clicked on the map.  An example of its use is given
in Figure 10, which shows Soil Survey information.  The Select Feature
button   allows one to pick a feature on the map and its linked
database tables.  The next button allows one to zoom into or magnify a
portion of the map, and the following one to zoom out each time it is
clicked on the map.  When Zoom Full is clicked on the map, the display
returns to maximum extent.  The Pan button allows one to move the
map sideways to view areas adjacent to the current display.  The
Measure button allows measurement of the distance in metres between
each point clicked on the map.  Finally, the Open Project button
terminates the current JCEMS program and allows one to change to
another program.  The program does not allow the user to save any
spatial changes, if any, as spatial elements are deliberately set to 'read-
only' and cannot be modified by the user. 

The Table Controls
When a table is selected rather than a map, the menu system

changes to one appropriate for managing tabular data.  Figure 3 shows
the control buttons.

14

Figure 2.  The Map Controls

Figure 3.  Table controls appear when a table is selected.
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The left button unselects any records selected i.e. highlighted in
yellow in the chosen table.  Operation of the Query button is described
in Appendix 1.  The Promote button moves selected records together at
the top of the table.  The Sort buttons operate whichever a field-labels
is highlighted in the table.  It immediately sorts the whole table
according to the values in that field.  For example, highlighting
Date_stock and then pressing Sort Dec button the records are sorted
from the latest to the earliest stocking date. 

The Tables menu option is used to modify data in a farm, nutrient
or other user modifiable table.  It allows records to be added or
changed, fields (columns) to be added and so on.  The process is
complex and should be undertaken only after suitable training.
Editing tables is described in Appendix 2.

Farm Summary Data
The whole farm information is obtained from the Farm program.

This gives a map of the Estate with tabular data below and to the side
if the map.  Selecting Dairy (see legend) using the select feature tool
button produces a display similar to Figure 4.  The selected area is
highlighted in yellow, and information related to the Dairy farm also
shows as yellow records.

15

Figure 4.  The Farm Data Spatial System with Dairy Information
Selected
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The table below the map shows summary data about the farm in
question.  Visible data include the area in m2, the season, date housed,
date of turnout to pasture and averages for the year of cows, cull cows,
other cows, in calf heifers, breeding stock 1-2 years old, etc.  In
addition, it shows the total slurry produced in m3 and the calculated
N, P and K loadings from animals assuming standard values (Anon,
1996) for manure composition.

The tables to the right of the map shows some samples of the data
recorded by the farm manager.  The lower table shows detailed stock
numbers taken from the monthly animal stocktaking.  The upper table
shows monthly comments inserted by the farm manager viz the animal
transfer or change details from the monthly stocktaking.

Nutrient Management
Nutrient information about individual plots or fields in the current

year is obtained by double clicking the Nutrients program icon on the
PC desktop.  The display format is shown in Figure 5.

16

Figure 5.  The nutrients management system at plot level.
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When a plot or field is selected using the Select Feature button, the
three charts at the bottom of the display change to reflect the N, P and
K status of the selected plot.  Two year's data are shown for the plot in
question.  The bars on the left of each chart illustrate the animal
nutrients applied to the plot.  The centre bars refer to the chemical
nutrients applied and the right hand bars gives the nutrient advised in
the most recent soil test report for that plot.  The latest nutrient status
information may be imported to the database and chart by clicking on
the update button referred to earlier.

A number of plots may be graphed side by side by using the select
feature on several plots with the keyboard shift button pressed.  It may
be necessary to zoom into the area in question before selecting plots
because when they are small, clicking on one may result in the
selection of several adjacent plots. 

Mapping Soil Fertility Levels
The soil fertility levels of individual plots are displayed by clicking

the Soil Fertility program icon.  The Soil Fertility display screen is
illustrated in Figure 6.  

17

Figure 6.  The soil fertility status of plots.
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The charts on the bottom of the display show the results of all soil
tests recorded by the system in the form of histograms.  The table on
the right of the display gives the plot code, the date of test and the all
the soil test data records for the selected plot.  The latest soil analysis
data may be imported by clicking on an update button on JCEMS. 

If one of the bar charts is selected (using the identify tool), then
information may be obtained by clicking on one of the bars.  Data
about that soil test will pop onto the screen as a small table. 

The soil P levels on the farmland at Johnstown Castle are shown in
Figure 7 and Figure 8 shows K levels on the farms.  The P levels reflect
the nature of the experimental programmes on the Dairy, Organic and
Beef farms and are not representative of farmland in general.  Thus
high soil P levels reflect the treatments that have been applied to the
plots.  A considerable area of the three farms shows high soil K values.
These may have been caused by the constraints imposed on manure
recycling on experimental land.

18

Figure 7.  Soil P levels

Nutrient Levels Johnstown Castle
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Monitoring Water Purity
The JCEMS includes a system to monitor point data on the purity

of water in the lakes and rivers flowing through the Estate.  Water
samples are taken each month at 18 points within and just outside the
Estate boundary.  They are analysed for pH, P, TON, NO3, nitrite NO2

and NH4 ions and the results of the analysis are maintained on a
database, which is accessible to staff on the local area network.To
ensure that the water purity information displayed on the JCEMS is
always up-to-date, when Estate water samples are analysed, an update
program is run to import the most recent analytical results to the water
database by clicking the update button in JCEMS.  Figure 9 shows the
water Purity systems of JCEMS.
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Figure 8.  Soil K values

Nutrient Levels Johnstown Castle
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The map of Johnstown Castle shows the three farms, coloured buff,
brick and light green and the forests and ornamental grounds are
coloured dark green.  The rivers are navy blue and the lakes light blue.
The 18 sampling points situated along the rivers, streams and lakes
are shown as red dots.  Figure 9 illustrates the water purity at a point
in woodland (dark green) about midway up and to the left of the map.
On clicking this point with the select feature button, the sample dot
becomes yellow and triggers a display of data in the table on the top
right of the screen and graphs along the bottom.  The data for the
selected point are highlighted in yellow in the spatial database table on
the top right.  

On the graph, data values below the X-axis indicate that analysis
was done but that the results were below the limit of detection of the
ion in question.  Zero value would indicate that the sample analysis
data was not available for the ion.

Figure 9. The JCEMS point water sample management system
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The Soils of Johnstown Castle
The soil map of Johnstown Castle Research Centre was included in

JCEMS as an aid to understanding differences in the behaviour of
nutrients in different plots, and to help the choice of land for laying out
of new experiments etc.  Table 12 gives a brief description of the
mapped soil units and the area and percentage area of each one.
Approximately 50% of the farmed soils are well drained to moderately
drained brown earths and the remainder are gleys with imperfect to
poor drainage characteristics.  The areas of woodland, lakes, wasteland
and the land surroundings buildings are included for completeness.
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Table 12:  Soil classification of the land area of Johnstown Castle

Map Unit Soil Group Drainage Texture Area ha % Total
Area

A1 Brown Earth Well / moderate Fine loamy 102.5 25.7

A2 Gley Imperfect Fine loamy 96.5 24.2

A3 Gley Poor Fine loamy 24.4 6.1

B1 Brown Podzolic/ Well Sandy 12.1 3
Brown Earth

B2 Brown Earth Moderate Sandy 5.3 1.3

C1 Brown Earth Well Coarse over fine loamy 25.9 6.5

C2 Gley Moderate / imperfect Coarse over fine loamy 14.7 3.7

C3 Gley Poor Coarse over fine loamy 6.9 1.7

Lakes/Rivers 12.2 3.1

Woodland 78.7 19.8

Building/
Other Land 18.0 4.5
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An image of the JCEMS computer screen is shown in Figure 10.
This illustrates the soil map and some tools for obtaining information.
The display is simpler than the other ones in JCEMS, the tool buttons
supplied can be used only for zooming, panning, measuring distances
and obtaining information about the soil at different points on the e-
map.  Thus, as with the other e-maps in JCEMS, the soil information
associated with any of the fields or experimental plots may be obtained
by clicking on the area in question with the mouse pointer.  Figure 10
shows the information window after the results of several queries have
popped onto the screen.
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Figure 10.  Soils of Johnstown Castle Estate
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The project would have been infinitely poorer without the help of
many colleagues, particularly John Murphy, Rioch Fox, Alan Cuddihy
and Noel Culleton of Johnstown Castle.

Anon (1996) A Code of Good Agriculture Practice to Protect Waters
from Pollution by Nitrates.  Dept. of the Environment & Dept. of
Agriculture, Food and Forestry.
Carton, O.T., (1998) Nutrient Management Plan, Teagasc, Johnstown
Castle.
Coulter, B.S., McDonald, E. and Lee, J. (1998) Enhancing and
Visualising Data on Soils, Landuse and the Environment, End of
Project Report No. 4104. Teagasc, Johnstown Castle.
Coulter, B.S., McDonald, E., Murphy, W. E. and Lee, J. (1999) Visual
Environmental Data on Soils and Landuse. End of Project Report No.
4496. Teagasc, Johnstown Castle.
Diamond, S. (1983)  The soils of Johnstown Castle.  Personal
communication.
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Using the Query Button to Build a Query

Use the query button        to build a query, choose a Field, an
Operator, and then a Value.  You build a query by double-clicking on
these options with the mouse or by typing your query directly into the
query text box.  By default, the query is contained within parentheses,
but the parentheses may not be required, depending on the complexity
of your query.  If the Update Values choice is on, click once on a field
name to list its values in the Values list.  Field names are always
enclosed in square brackets ([ ]).  If the value you want to use in the
query is not in the Values list, type it into the query text box.

For example, to select all the houses of more than 1,500 square feet,
you could use the query:
( [area] > 1500 )

Strings such as names are always quoted in queries.  Queries on non-
indexed fields are case insensitive, so you can select California with:
( [state_name] = "california" )

Use * as a multiple character wildcard.  For example, to select
Mississippi you could use the query:
( [state_name] = "missi*" )

Use ? in a string as a single character wildcard.  For example, to find
Catherine Smith and Katherine Smith, use:
( [owner_name] = "?atherine smith" )

To select all the cities with names starting with the letters M to Z, you
could use:
( [city_name] >= "m" )

Values in date fields contain eight digits in the format YYYYMMDD.
For example, the 10th of February 1972 would be represented as
19720210.  Dates are handled as date objects.  So when you are
querying a date field you can select all dates before today by using:
( [date] < Date.Now )

To select all the dates before a specific date, you could use:
( [date] < 19920717.AsDate )

24
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If you double-click a date in the Values list in the Query Builder dialog.
AsDate is entered into your expression automatically.  It tells ArcView
that the eight digit number is to be treated as a date in the expression. 

Another way to specify a date in an expression is to give the date as a
string and then tell ArcView what format you have given it in, so
ArcView can convert it to a eight digit date for you:
( [date] > Date.Make("03/15/1993", "MM/dd/yyyy") )

Values in boolean fields are either True or False.  So when you are
querying a boolean field you can select all the true values by using:
( [Wetland] = True ) 

Complex queries can be built by combining expressions together with
the And and Or operators.  For example, to select all the houses that
have more than 1,500 square feet and a garage for three or more cars,
use the query:
( [area] > 1500) and ( [garage] > 3 )

Use the Not operator to exclude.  For example, to select all the New
England states except Maine, use the query:
( [sub_region] = "N Eng") and ( not ( [state_name] = "Maine") )

Queries can compare the values of two fields.  For example to find all
the counties with a declining population, use the query:
( [pop1990] < [pop1980] )

Calculations can be included in queries.  For example, to find the
counties with a population density of less or equal to 25 people per
square mile, you could use the query:
( [pop1990] / [area] <= 25 )

Dialog box options
Fields: This lists the fields in the theme or table you are querying.  If
the Update Values choice is on, click once on a field to see all its values
listed in the Values list.  Double-click on a field to place it into the
query text box.  If you type in the name of a field instead of clicking in
this list, field names are not case sensitive, so typing Area, area or
AREA are all allowed.

Fields that have been hidden do not appear in the Field list.  If field
name aliases have been defined these aliases appear in the Fields list.

25
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Operators: Use these operators to specify relationships between
Fields and Values in a query.   click or double-click an operator to place
it into the query text box.  The operators are:

= equals
> greater than
< less than
<> not equal to
>= greater than or equal to
<= less than or equal to
( ) expressions enclosed in parentheses are evaluated first.

and both expressions are true, e.g. [area] >= 100 and [area] <= 200
or at least one expression is true, e.g. [rainfall] < 20 or [slope] > 35
not excludes, e.g. not [name] <= "california"

The mathematical operators + - * / and arbitrary expressions can
also be used in queries.

Values: This lists the values for the chosen Field.  Only unique values
are listed.  So for example if 5 features or records in the theme or table
you are querying have the same value for the chosen field, this value is
only listed once in the Values list.  Double-click a value to place it into
the query text box. If the value you want to use is not in the list, type
it into the query text box.  Values cannot be displayed for tables
containing more than 32765 records.

Update Values: By default, the Values list updates each time you
choose a field.  If there are a lot of values, it may take a moment for the
values to be updated.  Click this choice off if you don't want to update
the values.  This is particularly helpful if your query compares one field
to another and you don't need to see their values, or if want to type
specific values into the query text box instead of choosing them from
the Values list.

Query text box: This is where your query is displayed as you build
it.

Performing a query on a view or a table
If you are using the Query Builder to select features on a view or
records in a table, the following options are available for performing
your query:
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New Set: Makes a new selected set containing the features or records
selected in your query.  Features or records not in this set are
deselected.

Add To Set: Adds the features or records selected in your query to
the existing selected set.  If there is no existing selected set, the
features or records specified in the query become a new set.  Use this
option to widen your selection.

Select From Set: Selects the features or records in your query from
the existing selected set. Only those features or records in this existing
set that are selected in your query will remain in the selected set. Use
this option to narrow down your selection.

Performing a query to define a feature selection for a theme: If
you are using the Query Builder from the Theme Properties dialog box
to define a feature selection for a theme you will see OK and Cancel
buttons instead of New Set, Add To Set and Select From Set.

OK: Selects the features in your query and makes this query the
feature selection definition for the theme.  Only those features that
meet this definition will be represented in the theme.  The query is
added to the Theme Properties dialog box.

Cancel: Closes the Query Builder without running the query.

You can copy and paste queries.  For example, you might use the
Query Builder on a view to query a theme then decide to use this query
as the theme's feature selection definition.  In this case, you can copy
the query, open the Query Builder from the theme's Theme Properties
dialog box, and paste the query in.  To copy all or part of a query, select
what you want to copy and then press CTRL+C. To paste, press
CTRL+V.  There may be additional keyboard shortcuts on your
platform, e.g., in Windows you can also copy with CTRL+INS and paste
with SHIFT+INS.
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Using the editing features of ArcView

You can edit a database using the Table menu option which is
visible when a table is clicked.  In order to protect the integrity of
JCEMS, only user data, as distinct from spatial data may be edited and
saved.  The process is started by using the “Start Editing” option from
the Table Menu.

Adding a record

When editing is started, the option “Add Records” becomes enabled
(from being ‘greyed out’) in the Edit menu.  When this is selected, a
blank record (line is added to the bottom of table being edited.  To
insert data, the fields in this new record must be edited.

Editing a field

Press the Edit button        and thereafter, any field of any record
may be edited by clicking on the present contents and retyping.
After completion of editing, use the “Stop Editing” option from the
Table Menu.    The system will give the option Save Edits? and pressing
Yes will make the changes permanent.

To calculate a value for a field:

Choose Start Editing from the Table menu.

Click on the name of the field you wish to calculate.  Note that the
names of fields you can calculate appear in a normal font, any that
you can't are shown in italics.

Click the Calculate button.  In the Field Calculator dialog that
appears, type the expression for the calculation in the input area of
the dialog box.  You can use the field and request list items to help
you form the expression by double-clicking on field names and
requests or you can type the expression yourself.

Press OK to perform the calculation.  ArcView displays the results in
the table.
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The calculation applies to the selected set of records.  If no records
are selected, the calculation applies to all records. 

The calculation expression

The expression you type, in its simplest form, can just be a number,
a string, a date, or a boolean value.  For example, to set the value of a
string field named [Zoning] to the string "Industrial", type the string,
enclosed in double quotes in the text input area of the dialog box.  To
set the value of a number field to the number 143, type the number in
the text input area of the dialog box.

In addition, an expression may consist of any combination of field
names, enclosed in square brackets.  The result of the expression must
be a single object or value.  For example, to calculate the value of a field
named [Total Sales] as the product of the number of units, stored in a
field named [Units] and the unit price, stored in a field named [Price]
and also figure in the sales tax of 8.0%, type ( [Units] * [Price] ) * 1.08.
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